When this diagram is used to plan an essay, the blue box represents the

A Venn diagram is a great tool for brainstorming and creating a comparison between two or
more objects, events, or people. Simply draw two or three large circles and give each circle a
title, reflecting each object, trait, or person you are comparing. Inside the intersection of the two
circles overlapping area , write all the traits that the objects have in common. In the areas
outside the overlapping section, you will write all of the traits that are specific to that particular
object or person. From the Venn diagram above, you can create an easy outline for your paper.
Here is the beginning of an essay outline:. Both dogs and cats make great pets. Both have
drawbacks, as well. Cats can be easier to care for. Dogs can be better companions. As you can
see, outlining is much easier when you have a visual aid to help you with the brainstorming
process. Besides its usefulness for planning essays, Venn Diagrams can be used for thinking
through many other problems both at school and at home. For example:. Share Flipboard Email.
An Introduction to Essay Writing. Introduction Choosing a Topic. Writing an Introduction.
Structuring and Outlining. Types of Essays. Editing and Improving. Grace Fleming. Education
Expert. Grace Fleming, M. Cite this Article Format. Fleming, Grace. Venn Diagrams to Plan
Essays and More. Not sure which license you have? You can check what version you have.
Choose and open a template. Arrange and connect shapes. Add text to shapes and connectors.
Templates include stencils, shapes, and grid measurements to help you get started quickly and
easily when making your diagram. Templates come with stencils that are full of the shapes
needed to create a particular kind of drawing. The Home Plan template, for example, opens with
stencils full of shapes such as walls, furniture, appliances, cabinets, and so on. The
Organization Chart template includes distinct shapes for executives, managers, assistants,
positions, consultants, vacancies, and more. Some drawings require a special scale. For
example, the Site Plan template opens with an engineering scale, where 1 inch represents 10
feet. Templates come ready with appropriate settings for the drawing type. Some templates
have unique features that you can find on special tabs in the ribbon. For example, when you
open the Office Layout template, a Plan tab appears. You can use the Plan tab to configure
display options that are specific to office layout diagrams. For example, the Space Plan
template opens with a wizard that helps you set up your space and room information. If you
have Visio Plan 2, you can download and install the Visio desktop app. Select the template you
want, or select Basic Diagram to start from scratch. You can also browse for more templates by
clicking Categories , and you can enter terms to search for templates. If you're using the
desktop link, you may have to specify a specific type of that template and then select Create. To
create your diagram, you drag shapes from the stencil in the Shapes window to the canvas and
connect them. There are several ways to connect shapes, but the simplest way is with
AutoConnect arrows. If do not see the AutoConnect arrows when you hover the mouse pointer
over a shape, AutoConnect is not active. When you drag a shape from the Shapes window onto
your drawing page, the original shape remains on the stencil. That original is called a master
shape. The shape that you put on your drawing is a copy â€” also called an instance â€” of that
master. You can drag as many instances of the same shape onto your drawing as you want. You
can use the wide variety of diagram templates and stencils in Visio to understand, act on, and
share information about organizational systems, resources, and processes throughout your
enterprise. The round handle located above a selected shape is called a rotation handle. Drag it
right or left to rotate the shape. The connection arrows help you easily connect shapes to one
another, as you saw in the previous section. You can use the square selection handles to
change the height and width of your shape. Click and drag a selection handle on the corner of a
shape to enlarge the shape without changing its proportions, or click and drag a selection
handle on the side of a shape to make the shape taller or wider. You can add data to each shape
by typing it in the Shape Data window â€” on the View tab, in the Show group, click Task Panes
, and then click Shape Data. With Visio Professional Edition, you can also import data from an
external data source. Data is not displayed in the drawing by default. If you want to display the
data for lots of shapes at once, you can use a feature called data graphics, also on the Data tab.
The following illustration shows the data for two trees at once. Many Visio shapes have special
behavior that you can find by stretching, right-clicking, or moving the yellow control handle on
the shape. For example, you can stretch a People shape to show more people, or stretch the
Growing flower shape to indicate growth. The shapes automatically connect to show the
hierarchy. In the Shapes window, select a shape and drag it onto the canvas. Hold your mouse
over one of the arrows and a mini toolbar appears with the top four shapes in the Quick Shapes
area. Select the shape you want and it'll automatically connect to the arrow you selected. You
can also drag all your shapes onto the canvas. Then hold the mouse over a shape until the
arrows appear. Then grab an arrow and drag it to a shape you want to connect to. If you're
using the Visio desktop app, you can also drag a new shape directly from the Shapes window to
an existing shape's arrows and connect them automatically. Now it's time to add details to your

diagram by adding text. For more details about working with text, see Add, edit, move, or rotate
text on shapes and Add text to a page. Type your text. Add text to a connector the same way.
Click and drag it up, down, or beside the connector. On the Design tab, hover the mouse pointer
over the various themes. To see other available themes, click More. Click Design and then click
Backgrounds. Your diagram gets a new background, and, a new background page called
VBackground This page you can see in the page tabs along the bottom of the canvas. At the
bottom of the diagramming area, click the VBackground-1 tab. To edit other text in the border,
first select the entire border, and then click the text you want to change and start typing. You
may have to click more than once to get the text selected. Click Page-1 in the lower-right corner
of the page to return to the drawing. In some cases when you open a Visio template, a wizard
helps you get started. Open Visio on the web. Select Create under the template you want, or
select Create under Basic Diagram to start from scratch. To create your diagram, you drag
shapes from the stencil in the Shapes pane to the canvas and connect them. There are several
ways to connect shapes, but the simplest way is by auto-connecting them. For more details
about working with text, see Add and format text in Visio for the web. Drag a shape from the
Shapes window and drop it on the page. Leave the mouse pointer over the shape until four
arrows appear around the sides. These are AutoConnect arrows, which give you several ways
to automatically connect shapes. Hold the mouse pointer over one of the arrows and a mini
toolbar appears, holding the top four shapes in the Quick Shapes area. Move the pointer over
each to see a preview of that shape on your diagram. Click the one that you want, and that
shape appears with a connector between it and your first shape. Drag a shape from the Shapes
window and hold it over a shape on the page until the arrows appear, then drop the shape on
top of one of the arrows. Hold the pointer over a shape until the arrows appear, then grab an
arrow, drag it to a shape you want to connect to, and drop it in the middle of the second shape.
Click a shape once and start typing. Select a shape that has text. Click Home and use tools in
the Font and Paragraph groups to format the text. On the Design tab, in the Themes group,
move the pointer slowly over the different themes. Each theme adds different colors and effects
to the diagram. Click the one you want to apply. Click one of the background designs. Now look
down at the bottom of Visio, just under the drawing page. There are two tabs: Page-1 and
VBackground Page-1 is the page with the shapes on it, and VBackground-1 is a background
page you just added. Click VBackground-1 to see just the background page, and then click
Page-1 to go back to the diagram. Click one of the options to add it to the diagram. Notice the
border and title are added to the background page, so if you want to add the title, click the tab
for the background page. Now click Title once and start typing. The title changes to your new
text. Visio allows you to apply built-in templates, to apply your own custom templates, and to
search from a variety of templates available on Office. To use one of the built-in templates,
under Template Categories , click the category that you want, and then click the template that
you want and click Create. To use your own template that you previously created, under Other
Ways to Get Started , click New from existing , navigate to the file that you want and click Create
New. To find a template on Office. To search for templates on Office. In the Search Office. If you
have just opened Visio, proceed to the next step. When the diagram template opens, most of the
space is taken up with a blank diagramming page. Along the side is the Shapes window, which
contains several stencils full of shapes. The stencils are identified by title bars at the top of the
Shapes window; you might need to scroll the title bar pane to see them all. When you click a
stencil title bar, the shapes appear in the pane below. Click the File tab, and then click Open. In
the left pane of the Open dialog box, click the drive or folder that contains the drawing. In the
right pane of the Open dialog box, open the folder that contains the drawing that you want. You
can save your diagram as a standard Visio file that you can share with other people who have
Visio. In addition, there are many different formats that you can save your diagram in directly
from the Save As dialog box. Click Save As , and then select a format in the Save as type list.
Image files and other resource files are saved in a subfolder of the location where you save the
HTM file. From the Shapes window, click and hold the shape that you want. For more
information about how to add shapes, see Use the Shapes window to organize and find shapes
and Find more shapes and stencils. To add a shape to the drawing page so that it is
automatically connected when it is added to the page, do the following:. Hold your pointer over
the shape that is already on the page. Notice that small blue arrows appear on the four sides of
the shape. These are AutoConnect arrows that you can use to connect shapes. A mini toolbar
that contains four shapes appears, and a preview shape might also appear on the page. As you
move the pointer over the shapes in the mini toolbar, previews of the shapes appear. The
shapes on the toolbar are the top four shapes from the Quick Shapes area. To automatically
connect two shapes when you drag the second shape onto the page, do the following:. Drag a
second shape onto the drawing page and hold it so it covers the first shape, but do not drop it

yet. Notice that the AutoConnect arrows appear. Move the second shape down over the
AutoConnect arrow that points in the direction that you want, and drop it on the arrow. The
Analyze shape is spaced a standard distance from the Service Request shape, and is connected
automatically. When the AutoConnect arrows appear, move the pointer over an arrow that is
pointing toward the other shape that you want to connect to. Click and hold the AutoConnect
arrow, and then drag a connector from it to the center of the other shape. When the arrow is
over the center of the other shape, a red border appears around the shape. Drop the connector
to attach it, or "glue" it, to the shape. For more information about how to connect shapes, see
Add connectors between shapes in Visio. When you start typing, Visio switches the selected
shape to text editing mode. Select the shape again. A small yellow control handle appears in the
text area. Drag the yellow control handle to move the text. On the Home tab, in the Tools group,
click the Text tool. The text box now has the characteristics of other shapes. You can select it
and type to change the text, you can drag it to another part of the page, and you can format the
text by using the Font and Paragraph groups on the Home tab. In addition, when you hold the
pointer over the text, AutoConnect arrows appear so you can connect the text to other shapes.
For more information about how to add text blocks, see Add, edit, move, or rotate text and text
blocks. In the Shape Data window, in the property row that you want, enter the data that you
want. In the Define Shape Data dialog box, click New. In the Label box, delete the default text
and type a name for the property. In the Type list, select the type of data that you want to be
entered into that property. Right-click the shape again, point to Data , and this time click Shape
Data. The Shape Data window opens and displays all the data that has been defined for the
shape. If all of the shapes have specific information, you can leave the Shape Data window open
and click the shapes you are interested in to see the data that they contain. Adding shape data
manually can add a lot of value to your diagram, but if your data is in a database or an Excel
workbook, you can pull that data into your diagram automatically and connect the rows of data
with specific shapes. Use the Data Selector wizard to import your data into the External Data
window. The data that appears in the External Data window is a snapshot of your source data at
the time of import. You can update the data in your drawing to match the changes in your
source data by clicking Refresh All on the Data tab. On the first page of the Data Selector
wizard, choose which of the following types of data sources have the data you're using:. After
you click Finish on the last page of the Data Connection wizard, the External Data window
appears with your imported data shown in a grid. Drag a row of data onto a shape to add
automatically the data to the Shape Data for that shape. Or, in the Shapes window, select a
shape that you want to hold the data, and then drag a row of data and drop it on an empty area
of the page. The selected shape is added to the page, connected to the data. In the
Backgrounds group, click Backgrounds. Click the background that you want. A new
background page is added to the diagram, which you can see in the page tabs along the bottom
of the diagramming area. The title and border are added to the background page named
VBackground-1 by default. To change the title and other text, you must make the changes on
the background page; you can't change the title on any other pages. Click the title text. The
entire border is selected, but if you start typing it changes the default title text. To apply a
unified color scheme and other formatting effects:. On the Design tab, in the Themes group,
hold your pointer over the various themes. A preview of the theme shows up on the page.
Appropriate grid size and ruler measurements Some drawings require a special scale. Special
tabs Some templates have unique features that you can find on special tabs in the ribbon.
Rotating and resizing shapes Rotation handles The round handle located above a selected
shape is called a rotation handle. Connection arrows for AutoConnect The connection arrows
help you easily connect shapes to one another, as you saw in the previous section. Selection
handles for resizing shapes You can use the square selection handles to change the height and
width of your shape. Visio shapes can hold data You can add data to each shape by typing it in
the Shape Data window â€” on the View tab, in the Show group, click Task Panes , and then
click Shape Data. Visio shapes with special behavior Many Visio shapes have special behavior
that you can find by stretching, right-clicking, or moving the yellow control handle on the shape.
Visio temporarily applies each theme as you hover the mouse pointer over them. Click the
theme that you want to apply to the diagram. Click a background. Click a title style. The title and
border appear on the background page. The entire border is selected, but when you start typing
it changes the title text. Type your title, then press ESC. Tutorial: 3 basic steps to create a Visio
diagram: Choose and open a template Arrange and connect shapes Add text to shapes and
connectors Choose and open a template Templates include stencils, shapes, and grid
measurements to help you get started quickly and easily when making your diagram. Wizards to
help you with special types of drawings In some cases when you open a Visio template, a
wizard helps you get started. A subscription to make the most of your time. Try one month free.

Need more help? Expand your Office skills. Get new features first. Was this information helpful?
Yes No. Any other feedback? The more you tell us, the more we can help. How can we improve?
Send No thanks. Thank you for your feedback! It sounds like it might be helpful to connect you
to one of our Office support agents. Contact Support. The algorithm and flowchart are two types
of tools to explain the process of a program. In this page, we discuss the differences between
an algorithm and a flowchart and how to create a flowchart to illustrate the algorithm visually.
Algorithms and flowcharts are two different tools that are helpful for creating new programs,
especially in computer programming. An algorithm is a step-by-step analysis of the process,
while a flowchart explains the steps of a program in a graphical way. Writing a logical
step-by-step method to solve the problem is called the algorithm. In other words, an algorithm
is a procedure for solving problems. In order to solve a mathematical or computer problem, this
is the first step in the process. An algorithm includes calculations, reasoning, and data
processing. Algorithms can be presented by natural languages, pseudocode, and flowcharts,
etc. A flowchart is the graphical or pictorial representation of an algorithm with the help of
different symbols, shapes, and arrows to demonstrate a process or a program. With algorithms,
we can easily understand a program. The main purpose of using a flowchart is to analyze
different methods. Several standard symbols are applied in a flowchart:. The symbols above
represent different parts of a flowchart. The process in a flowchart can be expressed through
boxes and arrows with different sizes and colors. In a flowchart, we can easily highlight certain
elements and the relationships between each part. If you compare a flowchart to a movie, then
an algorithm is the story of that movie. In other words, an algorithm is the core of a flowchart.
Actually, in the field of computer programming, there are many differences between algorithm
and flowchart regarding various aspects, such as the accuracy, the way they display, and the
way people feel about them. Below is a table illustrating the differences between them in detail.
It is not surprising that algorithms are widely used in computer programming. However, it can
be applied to solving mathematical problems and even in everyday life. Here comes a question:
how many types of algorithms? According to Dr. As a result, he has listed 32 crucial algorithms
in computer science. Despite the complexity of algorithms, we can generally divide algorithms
into six fundamental types based on their function. It refers to a way to solve problems by
repeatedly breaking down the problem into sub-problems of the same kind. The classic example
of using a recursive algorithm to solve problems is the Tower of Hanoi. Traditionally, the divide
and conquer algorithm consists of two parts: 1. Developed by Richard Bellman in the s, the
dynamic programming algorithm is generally used for optimization problems. In this type of
algorithm, past results are collected for future use. Like the divide and conquer algorithm, a
dynamic programming algorithm simplifies a complex problem by breaking it down into some
simple sub-problems. This is another way of solving optimization problems â€” greedy
algorithm. It refers to always finding the best solution in every step instead of considering the
overall optimality. That is to say, what he has done is just at a local optimum. Due to the
limitations of the greedy algorithm, it has to be noted that the key to choosing a greedy
algorithm is whether to consider any consequences in the future. The brute force algorithm is a
simple and straightforward solution to the problem, generally based on the description of the
problem and the definition of the concept involved. You can also use "just do it! In short, a
brute force algorithm is considered as one of the simplest algorithms, which iterates all
possibilities and ends up with a satisfactory solution. Based on a depth-first recursive search,
the backtracking algorithm focusing on finding the solution to the problem during the
enumeration-like searching process. Now that we have learned the definitions of algorithm and
flowchart, how can we use a flowchart to represent an algorithm? To create an algorithm
flowchart, we need to use a handy diagramming tool like EdrawMax to finish the work.
Algorithms are mainly used for mathematical and computer programs, whilst flowcharts can be
used to describe all sorts of processes: business, educational, personal, and algorithms. So
flowcharts are often used as a program planning tool to organize the program's step-by-step
process visually. Here are some examples:. From the above, we can come to the conclusion
that a flowchart is a pictorial representation of an algorithm, an algorithm can be expressed and
analyzed through a flowchart. An algorithm shows you every step of reaching the final solution,
while a flowchart shows you how to carry out the process by connecting each step. An
algorithm uses mainly words to describe the steps while you can create a flowchart with
flowchart symbols to make the process more logical. How to Create a Fantastic Flowchart.
Examples of Algorithm Flowchart. Top 10 Creative Flowchart Templates. Neural Network
Diagram Examples. EdrawMax is an advanced all-in-one diagramming tool for creating
professional flowcharts, org charts, mind maps, network diagrams, UML diagrams, floor plans,
electrical diagrams, science illustrations, and more. Just try it, you will love it! Explain
Algorithm and Flowchart with Examples. Flowchart How To. Diagram Symbols. Popular Usage.

Algorithm and Flowchart Flowchart Examples for Students. Part 1: Definition of Algorithm. Part
2: Definition of Flowchart. Part 3: Difference between Algorithm and Flowchart. Part 4: Types of
Algorithm. Part 5: Use Flowcharts to Represent Algorithms. EdrawMax: a swiss knife for all your
diagramming need. Effortlessly create over types of diagrams. Drag and drop interface and easy
to use. Customize every detail by using smart and dynamic toolkits. Feel free to export, print,
and share your diagrams. Part 6: Conclusion. Get Started! You Will Love This Easy-To-Use
Diagram Software EdrawMax is an advanced all-in-one diagramming tool for creating
professional flowcharts, org charts, mind maps, network diagrams, UML diagrams, floor plans,
electrical diagrams, science illustrations, and more. In this chapter and Analyzing Starlight , we
described some of the characteristics by which we might classify stars and how those are
measured. These ideas are summarized in Table 1. We have also given an example of a
relationship between two of these characteristics in the mass-luminosity relation. When the
characteristics of large numbers of stars were measured at the beginning of the twentieth
century, astronomers were able to begin a deeper search for patterns and relationships in these
data. Measure the spectrum and get the spectral type. Chemical composition Determine which
lines are present in the spectrum. Luminosity Measure the apparent brightness and compensate
for distance. Radial velocity Measure the Doppler shift in the spectrum. Rotation Measure the
width of spectral lines. Mass Measure the period and radial velocity curves of spectroscopic
binary stars. Diameter 1. Measure the light curves and Doppler shifts for eclipsing binary stars.
Figure 1. Height versus Weight: The plot of the heights and weights of a representative group of
human beings. If you want to understand humans by comparing and contrasting their
characteristicsâ€”without assuming any previous knowledge of these strange creaturesâ€”you
could try to determine which characteristics lead you in a fruitful direction. For example, you
might plot the heights of a large sample of humans against their weights which is a measure of
their mass. Such a plot is shown in Figure 1 and it has some interesting features. In the way we
have chosen to present our data, height increases upward, whereas weight increases to the left.
Notice that humans are not randomly distributed in the graph. Most points fall along a sequence
that goes from the upper left to the lower right. We can conclude from this graph that human
height and weight are related. Generally speaking, taller human beings weigh more, whereas
shorter ones weigh less. This makes sense if you are familiar with the structure of human
beings. Typically, if we have bigger bones, we have more flesh to fill out our larger frame. And,
of course, there are some dramatic exceptions. You occasionally see a short human who is very
overweight and would thus be more to the bottom left of our diagram than the average
sequence of people. Or you might have a very tall, skinny fashion model with great height but
relatively small weight, who would be found near the upper right. A similar diagram has been
found extremely useful for understanding the lives of stars. In , American astronomer Henry
Norris Russell plotted the luminosities of stars against their spectral classes a way of denoting
their surface temperatures. This investigation, and a similar independent study in by Danish
astronomer Ejnar Hertzsprung , led to the extremely important discovery that the temperature
and luminosity of stars are related Figure 2. Figure 2. Hertzsprung â€” and Russell â€” : a Ejnar
Hertzsprung and b Henry Norris Russell independently discovered the relationship between the
luminosity and surface temperature of stars that is summarized in what is now called the Hâ€”R
diagram. His memory was so phenomenal, he could correctly quote an enormous number of
poems and limericks, the entire Bible, tables of mathematical functions, and almost anything he
had learned about astronomy. He was nervous, active, competitive, critical, and very articulate;
he tended to dominate every meeting he attended. In outward appearance, he was an
old-fashioned product of the nineteenth century who wore high-top black shoes and high
starched collars, and carried an umbrella every day of his life. His papers were enormously
influential in many areas of astronomy. Born in , the son of a Presbyterian minister, Russell
showed early promise. When he was 12, his family sent him to live with an aunt in Princeton so
he could attend a top preparatory school. He lived in the same house in that town until his death
in interrupted only by a brief stay in Europe for graduate work. He was fond of recounting that
both his mother and his maternal grandmother had won prizes in mathematics, and that he
probably inherited his talents in that field from their side of the family. Before Russell, American
astronomers devoted themselves mainly to surveying the stars and making impressive catalogs
of their properties, especially their spectra as described in Analyzing Starlight. Russell began to
see that interpreting the spectra of stars required a much more sophisticated understanding of
the physics of the atom, a subject that was being developed by European physicists in the s
and s. Russell embarked on a lifelong quest to ascertain the physical conditions inside stars
from the clues in their spectra; his work inspired, and was continued by, a generation of
astronomers, many trained by Russell and his collaborators. Russell also made important
contributions in the study of binary stars and the measurement of star masses, the origin of the

solar system, the atmospheres of planets, and the measurement of distances in astronomy,
among other fields. He was an influential teacher and popularizer of astronomy, writing a
column on astronomical topics for Scientific American magazine for more than 40 years. He and
two colleagues wrote a textbook for college astronomy classes that helped train astronomers
and astronomy enthusiasts over several decades. That book set the scene for the kind of
textbook you are now reading, which not only lays out the facts of astronomy but also explains
how they fit together. Russell gave lectures around the country, often emphasizing the
importance of understanding modern physics in order to grasp what was happening in
astronomy. Today, one of the highest recognitions that an astronomer can receive is an award
from the American Astronomical Society called the Russell Prize, set up in his memory. Figure
3. Along the horizontal axis, we can plot either temperature or spectral type also sometimes
called spectral class. Several of the brightest stars are identified by name. Most stars fall on the
main sequence. Following Hertzsprung and Russell, let us plot the temperature or spectral class
of a selected group of nearby stars against their luminosity and see what we find Figure 3. Such
a plot is frequently called the Hertzsprungâ€”Russell diagram , abbreviated Hâ€”R diagram. It is
one of the most important and widely used diagrams in astronomy, with applications that
extend far beyond the purposes for which it was originally developed more than a century ago.
It is customary to plot Hâ€”R diagrams in such a way that temperature increases toward the left
and luminosity toward the top. Notice the similarity to our plot of height and weight for people
Figure 1. Stars, like people, are not distributed over the diagram at random, as they would be if
they exhibited all combinations of luminosity and temperature. Instead, we see that the stars
cluster into certain parts of the Hâ€”R diagram. The great majority are aligned along a narrow
sequence running from the upper left hot, highly luminous to the lower right cool, less
luminous. This band of points is called the main sequence. It represents a relationship between
temperature and luminosity that is followed by most stars. We can summarize this relationship
by saying that hotter stars are more luminous than cooler ones. A number of stars, however, lie
above the main sequence on the Hâ€”R diagram, in the upper-right region, where stars have low
temperature and high luminosity. How can a star be at once cool, meaning each square meter
on the star does not put out all that much energy, and yet very luminous? The only way is for
the star to be enormousâ€”to have so many square meters on its surface that the total energy
output is still large. These stars must be giants or supergiants , the stars of huge diameter we
discussed earlier. Figure 4. Schematic Hâ€”R Diagram for Many Stars: Ninety percent of all
stars on such a diagram fall along a narrow band called the main sequence. A minority of stars
are found in the upper right; they are both cool and hence red and bright, and must be giants.
Some stars fall in the lower left of the diagram; they are both hot and dim, and must be white
dwarfs. There are also some stars in the lower-left corner of the diagram, which have high
temperature and low luminosity. If they have high surface temperatures, each square meter on
that star puts out a lot of energy. How then can the overall star be dim? It must be that it has a
very small total surface area; such stars are known as white dwarfs white because, at these
high temperatures, the colors of the electromagnetic radiation that they emit blend together to
make them look bluish-white. We will say more about these puzzling objects in a moment.
Figure 4 is a schematic Hâ€”R diagram for a large sample of stars, drawn to make the different
types more apparent. Now, think back to our discussion of star surveys. It is difficult to plot an
Hâ€”R diagram that is truly representative of all stars because most stars are so faint that we
cannot see those outside our immediate neighborhood. The stars plotted in Figure 3 were
selected because their distances are known. To be truly representative of the stellar population,
an Hâ€”R diagram should be plotted for all stars within a certain distance. Unfortunately, our
knowledge is reasonably complete only for stars within 10 to 20 light-years of the Sun, among
which there are no giants or supergiants. These estimates can be used directly to understand
the lives of stars. Permit us another quick analogy with people. Suppose we survey people just
like astronomers survey stars, but we want to focus our attention on the location of young
people, ages 6 to 18 years. Survey teams fan out and take data about where such youngsters
are found at all times during a hour day. Some are found in the local pizza parlor, others are
asleep at home, some are at the movies, and many are in school. After surveying a very large
number of young people, one of the things that the teams determine is that, averaged over the
course of the 24 hours, one-third of all youngsters are found in school. How can they interpret
this result? Does it mean that two-thirds of students are truants and the remaining one-third
spend all their time in school? No, we must bear in mind that the survey teams counted
youngsters throughout the full hour day. Some survey teams worked at night, when most
youngsters were at home asleep, and others worked in the late afternoon, when most
youngsters were on their way home from school and more likely to be enjoying a pizza. If the
survey was truly representative, we can conclude, however, that if an average of one-third of all

youngsters are found in school, then humans ages 6 to 18 years must spend about one-third of
their time in school. We can do something similar for stars. The fusion of protons to helium is
an excellent, long-lasting source of energy for a star because the bulk of every star consists of
hydrogen atoms, whose nuclei are protons. But if all the stars on the main sequence are doing
the same thing fusing hydrogen , why are they distributed along a sequence of points? That is,
why do they differ in luminosity and surface temperature which is what we are plotting on the
Hâ€”R diagram? To help us understand how main-sequence stars differ, we can use one of the
most important results from our studies of model stars. Astrophysicists have been able to show
that the structure of stars that are in equilibrium and derive all their energy from nuclear fusion
is completely and uniquely determined by just two quantities: the total mass and the
composition of the star. This fact provides an interpretation of many features of the Hâ€”R
diagram. In such a cloud, all the clumps of gas and dust that become stars begin with the same
chemical composition and differ from one another only in mass. Now suppose that we compute
a model of each of these stars for the time at which it becomes stable and derives its energy
from nuclear reactions, but before it has time to alter its composition appreciably as a result of
these reactions. The models calculated for these stars allow us to determine their luminosities,
temperatures, and sizes. If we plot the results from the modelsâ€”one point for each model
starâ€”on the Hâ€”R diagram, we get something that looks just like the main sequence we saw
for real stars. And here is what we find when we do this. The model stars with the largest
masses are the hottest and most luminous, and they are located at the upper left of the diagram.
The least-massive model stars are the coolest and least luminous, and they are placed at the
lower right of the plot. The other model stars all lie along a line running diagonally across the
diagram. In other words, the main sequence turns out to be a sequence of stellar masses. This
makes sense if you think about it. The most massive stars have the most gravity and can thus
compress their centers to the greatest degree. This means they are the hottest inside and the
best at generating energy from nuclear reactions deep within. As a result, they shine with the
greatest luminosity and have the hottest surface temperatures. The stars with lowest mass, in
turn, are the coolest inside and least effective in generating energy. Thus, they are the least
luminous and wind up being the coolest on the surface. Our Sun lies somewhere in the middle
of these extremes as you can see in Figure 3. The characteristics of representative
main-sequence stars excluding brown dwarfs, which are not true stars are listed in Table 2. This
is exactly what we found earlier when we examined the mass-luminosity relation. Our models
and our observations agree. What about the other stars on the Hâ€”R diagramâ€”the giants and
supergiants, and the white dwarfs? As a star consumes its nuclear fuel, its source of energy
changes, as do its chemical composition and interior structure. These changes cause the star
to alter its luminosity and surface temperature so that it no longer lies on the main sequence on
our diagram. Because stars spend much less time in these later stages of their lives, we see
fewer stars in those regions of the Hâ€”R diagram. We can use the Hâ€”R diagram to explore
the extremes in size, luminosity, and density found among the stars. Such extreme stars are not
only interesting to fans of the Guinness Book of World Records ; they can teach us a lot about
how stars work. For example, we saw that the most massive main-sequence stars are the most
luminous ones. These superluminous stars, which are at the upper left of the Hâ€”R diagram,
are exceedingly hot, very blue stars of spectral type O. These are the stars that would be the
most conspicuous at vast distances in space. Figure 5. The cool supergiants in the upper
corner of the Hâ€”R diagram are as much as 10, times as luminous as the Sun. In addition,
these stars have diameters very much larger than that of the Sun. In contrast, the very common
red, cool, low-luminosity stars at the lower end of the main sequence are much smaller and
more compact than the Sun. This combination of mass and diameter means that it is so
compressed that the star has an average density about 80 times that of the Sun. Its density
must be higher, in fact, than that of any known solid found on the surface of Earth. Despite this,
the star is made of gas throughout because its center is so hot. The faint, red, main-sequence
stars are not the stars of the most extreme densities, however. The white dwarfs, at the
lower-left corner of the Hâ€”R diagram, have densities many times greater still. Figure 6. Sirius
B is the faint speck in the lower left had quadrant of the image, and nearly lost in the glare of
bright Sirius A. Sirius B is much brighter in X-rays and is the bright object at the center of the
image. Above and slightly to the right is Sirius A. The first white dwarf star was detected in
Called Sirius B, it forms a binary system with Sirius A, the brightest-appearing star in the sky. It
eluded discovery and analysis for a long time because its faint light tends to be lost in the glare
of nearby Sirius A Figure 5. Since Sirius is often called the Dog Starâ€”being the brightest star
in the constellation of Canis Major, the big dogâ€”Sirius B is sometimes nicknamed the Pup. We
have now found thousands of white dwarfs. A good example of a typical white dwarf is the
nearby star 40 Eridani B. Calculations show that its radius is only 1. Its mass, however, is 0. A

teaspoonful of this material would have a mass of some 50 tons! At such enormous densities,
matter cannot exist in its usual state; we will examine the particular behavior of this type of
matter in The Death of Stars. For now, we just note that white dwarfs are dying stars, reaching
the end of their productive lives and ready for their stories to be over. The British astrophysicist
and science popularizer Arthur Eddington â€” described the first known white dwarf this way:.
A ton of my material would be a little nugget you could put in a matchbox. Today, however,
astronomers not only accept that stars as dense as white dwarfs exist but as we will see have
found even denser and stranger objects in their quest to understand the evolution of different
types of stars. The Hertzsprungâ€”Russell diagram, or Hâ€”R diagram, is a plot of stellar
luminosity against surface temperature. Most stars lie on the main sequence, which extends
diagonally across the Hâ€”R diagram from high temperature and high luminosity to low
temperature and low luminosity. The position of a star along the main sequence is determined
by its
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mass. High-mass stars emit more energy and are hotter than low-mass stars on the main
sequence. Main-sequence stars derive their energy from the fusion of protons to helium. Hâ€”R
diagram: Hertzsprungâ€”Russell diagram a plot of luminosity against surface temperature or
spectral type for a group of stars. Skip to main content. The Stars: A Celestial Census. Search
for:. The Hâ€”R Diagram Learning Objectives By the end of this section, you will be able to:
Identify the physical characteristics of stars that are used to create an Hâ€”R diagram, and
describe how those characteristics vary among groups of stars Discuss the physical properties
of most stars found at different locations on the Hâ€”R diagram, such as radius, and for main
sequence stars, mass. Licenses and Attributions. CC licensed content, Shared previously.
Determine the color very rough. Measure the apparent brightness and compensate for distance.
Measure the period and radial velocity curves of spectroscopic binary stars.

